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Overview 

Stellar Converter for Mail software converts mailboxes from Apple Mail (MBOX, EMLX), 

Thunderbird (MBOX), PostBox (MBOX), Outlook 2011 Backup File 2011 (OLM), Eudora 

(MBOX), SeaMonkey (MBOX), MailMate (EML), Outspring Mail (EML, F.EML) and Opera 

Mail (MBS) to Apple Mail (MBOX) and Outlook 2011 (RGE). You can import converted 

mailboxes in Apple Mail / Outlook 2011 to view complete mail body, including 

attachments. The software converts all emails, including attachments, without making any 

changes to the folder organization. 

What's New in this version? 

 Supports preview of converted mails. 

 New and enhanced GUI. 

 Converts Eudora (MBOX) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts SeaMonkey (MBOX) to Outlook 2011 (RGE) as well as Apple Mail 

(MBOX) 

 Converts MailMate (EML) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

 Converts Outspring Mail (EML, F.EML) to Outlook 2011 (RGE) as well as Apple 

Mail (MBOX) 

 Converts Opera Mail (MBS) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 

Key Features of Stellar Converter for Mail: 

 Converts Apple Mail (MBOX) to Outlook 2011 (RGE) 

 Converts Apple Mail (EMLX) to Outlook 2011 (RGE) 

 Converts Outlook 2011 Backup File (OLM) to Apple Mail (MBOX) 

 Converts Thunderbird (MBOX) to Outlook 2011 (RGE) as well as Apple Mail 

(MBOX) 



 
 

 

 Converts PostBox (MBOX) to Outlook 2011 (RGE) as well as Apple Mail (MBOX) 



 

Installation Procedure 

Before installing the software, check that your computer meets the minimum system 

requirements: 

Minimum System Requirements: 

 Processor : Intel Processor 

 Operating System : Mac OS X 10.7 and above 

 Memory : 1 GB RAM 

To install the software, follow these steps: 

1. Unzip StellarConverterforMail.dmg.zip file. 

2. Double-click the dmg file. This will mount a virtual volume - 

StellarConverterforMail. 

3. Drag StellarConverterforMail application from mounted virtual volume to 

Applications folder. 

4. To launch the software, double-click on Stellar Converter for Mail in Applications 

folder. 

5. Accept the License Agreement and the main window of Stellar Converter for Mail 

software is displayed 

Note: To remove the software, drag and drop Stellar Converter for Mail from 

Applications folder to Trash.   

  



 
 

 

Launching the Software 

You can use any of the following methods to start Stellar Converter for Mail: 

 Double-click  Stellar Converter for Mail in Applications folder, 

Or, 

 Double-click  Stellar Converter for Mail desktop shortcut (if you have created one), 

Or, 

 Click  Stellar Converter for Mail icon in the dock (if it exists). 

  



User Interface 

Stellar Converter for Mail software has a very easy to use Graphical User Interface. 

User interface contains features required for conversion. 

After launching the software, you will see the main user interface as shown below: 

 

The user interface contains Menus and Buttons that let you access various features of 

the software with ease. 

  



 
 

 

Menus 

StellarConverterforMail Menu 

About StellarConverterforMail 

Use this option to read more information 

about the software. 

Services 

Use this option to browse the services 

offered by the software. 

Hide StellarConverterforMail 

Use this option to hide the icon of this 

software on your screen. 

Hide Others 

Use this option to hide other software 

icons on your screen. 

Quit StellarConverterforMail 

Use this option to quit Stellar Converter 

for Mail. 

  

 

  

File Menu 

Open File 

Click on this option and select the 
desired file from which you want to 
convert the data. 

 



Save Converted File 

Use this option to save the converted file 
in the desired location. 

Tools Menu 

Register 

Use this option to register the software 
after purchasing. 

  

 

Help Menu 

Help Topics 

Use this option to view the help 

manual for the software. 

Order Stellar Converter for Mail 

Use this option to buy Stellar 

Converter for Mail. 

Email to Stellar Support 

Use this option to send an e-mail to 

stellarinfo.com. 

View Support Section 

Use this option to view support page 

of stellarinfo.com. 

Submit Enquiry 

Use this option to submit enquiry to 

stellarinfo.com. 

  
  
  
  
  
  

 

http://www.stellarinfo.com/email-tools/email-converter-mac/buy-now.php
mailto:support@stellarinfo.com
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 
 

 

View Knowledgebase Articles 

Use this option to visit 

Knowledgebase articles of 

stellarinfo.com. 

  

http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/


Buttons 

 

Click this button to open help manual for the software. 

 

Click this button to select the desired file from which you want to convert the 

data. 

 

Click this button to save the converted file in the desired location. 

 

Click this button to start the conversion process. 

 

Click this button to stop the conversion process. 

  



 
 

 

Ordering the Software 

Click here to know more about Stellar Converter for Mail. 

To purchase the software online, please visit http://www.stellarinfo.com/email-

tools/email-converter-mac/buy-now.php  

Alternatively, click Order Stellar Converter for Mail in Help Menu to purchase the 

software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which 

would be required to activate the software. 

  

http://www.stellarinfo.com/email-tools/email-converter-mac.php
http://www.stellarinfo.com/email-tools/email-converter-mac/buy-now.php
http://www.stellarinfo.com/email-tools/email-converter-mac/buy-now.php


Registering the Software 

To register Stellar Converter for Mail: 

1. Select Register from Tools menu. 

2. If you have the key, select I have a key to register the product from Stellar 

Converter for Mail dialog box and click OK. Enter the registration key and click OK 

to register the software. 

Or, 

If you don't have the registration key, select I don't have a key to register the 

product to purchase the software online. Once you purchase the software, you'll get 

the key required to register the software. 

3.  If entered key is valid, Product is registered successfully message will be 

displayed. Click OK. 

 

  



 
 

 

Stellar Support 

Our Technical Support professionals will give an appropriate solution to all your queries 

related to Stellar products. 

You can either call us or go to our online support section at 

http://www.stellarinfo.com/support/ 

For price details and to place an order, click http://www.stellarinfo.com/email-tools/email-

converter-mac/buy-now.php  

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-tools/email-converter-mac/buy-now.php
http://www.stellarinfo.com/email-tools/email-converter-mac/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com


 

Select Mailbox 

To select a mailbox for conversion: 

 In the main window of the Stellar Converter for Mail, click on Open button on the 

tool bar to open the desired file. 

Or, alternatively, you can also click on Open File option in the File Menu to select 

the file to be converted. 

 Select the format of the mailbox that you want to convert from the Choose Mail 

Client list box. 

 By default, the location of the database file is mentioned in the Select Database 

File box. Click Browse to select the mailbox from the different location. 

 

  Click Start button to start the conversion process. 



 
 

 

 

Note: To select hidden Apple Mail, Thunderbird, PostBox, Eudora, SeaMonkey, 

MailMate, Outspring Mail and Opera Mail mailboxes, copy them to preferred location in 

order to select them. 

  



Preview Mailbox Items 

Once you select mail client and press 'Start' button, the software starts the process of 

conversion. After the process is finished, a preview of converted mailbox is generated in 

a three pane window. 

 

The left pane shows mail item folder as Mails, in a tree view. The middle pane displays 

the list of items in a single mail item folder and the right pane shows the content of 

selected individual item. To see the content of a mail item folder, simply click on it in the 

tree view. 

  



 
 

 

Save the Converted File 

After the scanning of the mailbox you can save the converted file to Outlook 2011 (RGE) 

and Apple Mail (MBOX) format. To save the file, follow the underlying steps: 

 In the main window of the Stellar Converter for Mail, click on Open button on the 

tool bar to open the desired file. 

Or, alternatively, you can also click on Open File option in the File Menu to select 

the file to be converted. 

 Select the folder from the left pane of the preview window. Click on Save button 

on the tool bar to save the converted files. 

Or, alternatively, you can also click on Save Converted File option in the File Menu 

to perform the same task. 

 Select the format in which converted mailbox has to be saved. Select Outlook 

2011 to save converted file in '.rge' format or Select Apple Mail to save converted 

file in '.mbox' format. 

 Click OK button. 



 

 A 'Open Directory' dialog box is displayed. Select the destination path for saving 

the file. Click on 'Open' button to start the saving process. 

 A dialog box is displayed showing progress of the saving process. You can click 

Stop button in the dialog box to stop the file save process. 



 
 

 

 

 The file will be saved by the name 'Main Identity.rge' or 'Main Identity.mbox'. A 'File 

Saved Successfully' dialog appears. 

  



Import Converted Mailbox to Apple Mail 

To import the converted mailbox to Apple Mail: 

 Open Apple Mail. 

 From File Menu, select Import Mailboxes. 

 

 In Import dialog box, select Files in mbox format and click Continue. 

 

 Select the mailbox you want to import and click Choose. 



 
 

 

 

The selected mailbox will be imported to Apple Mail. Click Done to view the mailbox. 

  



Import Converted Mailbox to Outlook 2011 

To import RGE file in Microsoft Outlook 2011: 

 Open Microsoft Outlook 2011. Select Import from File Menu. 

 

 In Begin Import dialog box, select Entourage information from an archive or 

earlier version. Click right arrow to continue. 

 

 In Choose an Application dialog box, select Entourage archive (.rge). Click right 

arrow to continue 



 
 

 

 

 In Import dialog box, locate and select the file that you want to import. Click 

Import. 

 



 

FAQs 

1. What does the Stellar Converter for Mail do? 

Stellar Converter for Mail software converts mailboxes from Apple Mail (MBOX, 

EMLX), Thunderbird (MBOX), PostBox (MBOX), Outlook 2011 Backup File 2011 

(OLM), Eudora (MBOX), SeaMonkey (MBOX), MailMate (EML), Outspring Mail (EML, 

F.EML) and Opera Mail (MBS) to Apple Mail (MBOX) and Outlook 2011 (RGE), after 

which they can be imported in Apple Mail / Outlook 2011 to view the complete mail body, 

including the attachments. 

2. Is it necessary to install MS Outlook on the computer before converting 

mailboxes? 

You can convert mailboxes to Outlook 2011 format without installing MS Outlook on 

your computer. However, to view the converted mailbox, you need to install MS Outlook 

on your computer. 

3. What is the difference between demo version and full version of Stellar 

Converter for Mail? 

Demo version of the software allows you to preview the mailbox data. To save the 

converted mailbox data, you need to purchase the software. 

4. How do I extract selective folders from my source mailbox? 

The software facilitates you to select the desired folders from the scanned list to perform 

selective conversion. This is useful when you don’t require converting the complete 

Mailbox. 

5. What are the steps to open a RGE file in MS Outlook? 

To import RGE files in MS Outlook, please refer to Import Converted Mailbox to Outlook 

2011 section. 

6. What are the steps to open a MBOX file in Apple mail? 



 
 

 

To import MBOX file in Apple mail, please refer to Import Converted Mailbox to Apple 

Mail section. 



 

Legal Notices 

Copyright 

Stellar Converter for Mail software, accompanied user manual and documentation are 

copyright of Stellar Information Technology Private Limited, with all rights reserved. Under 

the copyright laws, this user manual cannot be reproduced in any form without the prior 

written permission of Stellar Information Technology Private Limited No Patent Liability is 

assumed, however, with respect to the use of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product 

specifications, is subject to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO 

WARRANTY WITH REGARD TO THIS MANUAL OR ANY OTHER INFORMATION 

CONTAINED HEREIN AND HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED 

WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR 

PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR INFORMATION 

TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR 

TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR 

DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN NO EVENT 

SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE LIABLE 

FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR 

IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED 

HEREIN OR THE USE THEREOF. 

Trademarks 



 
 

 

Stellar Converter for Mail® is a registered trademark of Stellar Information Technology 

Private Limited 

Mac OS X® is a registered trademark of Apple Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their 

respective companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, 

COPYING, ACCESSING OR USING THIS SOFTWARE, ALL OR ANY PORTION OF 

THIS SOFTWARE, YOU (HEREINAFTER “CUSTOMER”) ACCEPT ALL THE TERMS 

AND CONDITIONS OF THIS AGREEMENT WHICH WILL BIND YOU. THE TERMS OF 

THIS LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT 

LICENSE THE SOFTWARE AND DOCUMENTATION TO YOU AND YOU MUST 

DISCONTINUE THE INSTALLATION PROCESS NOW, AND PROMPTLY RETURN 

THE SOFTWARE AND PROOF OF ENTITLEMENT TO THE PARTY FROM WHOM 

YOU ACQUIRED THE SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office 

at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating 

system and hardware configuration as stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or 

similar form and manipulates it for a specific result based on a sequence of instructions, 

including without limitation desktop computers, laptops, tablets, mobile devices, 

telecommunication devices, Internet-connected devices, and hardware products 

capable of operating a wide variety of productivity, entertainment, or other software 

applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on 

whose behalf it is used; for example, and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid 

license (e.g., volume license) granted by Stellar. 



 
 

 

1.6 “Software” means (a) all of the information with which this agreement is provided, 

including but not limited to: (i) all software files and other computer information; (ii) any 

proprietary scripting logic embedded within exported file formats (iii)images, sounds, clip 

art, video and other works bundled with Stellar software or made available by Stellar on 

Stellar’s website for use with the Stellar software and not obtained from Stellar through 

a separate service (unless otherwise noted within that service) or from another party 

(“Content Files”); (iv) related explanatory written materials and files (“Documentation”); 

and (v) any modified versions and copies of, and upgrades, updates, and additions to, 

such information, provided to Customer by Stellar at any time, to the extent not provided 

under separate terms (collectively, “Updates”). 

2. LICENSE GRANT; PROPRIETARY RIGHTS 

Right to use the Software: Subject to the terms and conditions of this Agreement, 

Stellar grants Customer a non-exclusive, non-transferable right, revocable and limited 

license to access and use the Software and Documentation on a single computer or 

workstation in a single location for your personal purposes (if you are a consumer) or 

your internal business purposes (if you are a business user) subject to the terms stated 

below. Customer must use the Technician License if using the software to provide 

professional or paid service to a third party (individual or company) and / or for any 

commercial purposes.   

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and 

used only by a single USER on a single computer at any one time. Consequently, the 

SOFTWARE must not be installed, displayed, shared or used concurrently from the 

computer or on distinct computers. Single User License is granted to customer who is 

using STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of the 

Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and 

used by a specified number of USERS representing an equivalent number of 

computers. The SOFTWARE must not be installed, displayed, shared or used from or 

on a number of computers greater than the number of workstations authorized. Multiple 



User License are associated with Technician & Toolkit Edition of the Software. 

MAXIMUM Installation and usage limit of this License in on 3 Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without 

License key which can be downloaded for free from Stellar’s website. The Software may 

only be installed and used on Permitted Number of Compatible Computers during the 

License Term for demonstration, evaluation, and training purposes only. Evaluation 

Software or Trial version of the Software may be freely distributed, if the distribution 

package is not modified. No person or company may charge a fee for the distribution of 

trial version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis 

(“Subscription License”), Customer may install and use the Subscription License only on 

the Permitted Number of Compatible Computer during the License Term Period. 

Subject to the Permitted Number of Computers for the Subscription License, Customer 

agrees that Stellar may change the type of Software (such as specific components, 

versions, platforms, languages, etc.) included in the Subscription License at any time 

and shall not be liable to the Customer whatsoever for such change. Ongoing access to 

a Subscription License requires a recurring Internet connection to activate, renew, and 

validate the license. If Stellar does not receive the recurring subscription payment or 

cannot validate the license periodically, then the Software may become inactive without 

additional notice until Stellar receives the payment or validates the license. 

3.3 Lifetime License: Once registered, user is granted an exclusive license to use the 

Software for maximum period of 10 years on the same computer with same 

configuration and operating system which is compatible with the software. If the 

computer hardware or software is changed during the lifetime of the license which is not 

compatible with the original purchased version; then user may need to additionally 

purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT.      



 
 

 

Support will only be provided to only license customer for a period of 1 Year from the 

date of purchase. Queries regarding the installation and use of the software should be 

submitted by e-mail which get responded usually within 24 Business Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license 

term is greater than 1 year then you may avail Technical Support by paying additional 

fee applicable at that time. Paid support can be purchased for Lifetime License only 

upto a maximum period of next 2 years. Stellar will not assist customers for any support 

request related to the Software after 3 years from the purchase of the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual 

property of and are owned by Stellar. The structure, organization, and source code of 

the Software are the valuable trade secrets and confidential information of Stellar 

Information Technology Pvt. Ltd. The Software is protected by law, including but not 

limited to the copyright laws of the United States and other countries, and by 

international treaty provisions. Except as expressly stated herein, this agreement does 

not grant Customer any intellectual property rights in the Software. All rights not 

expressly granted are reserved by Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without 

limitation Documentation) that Customer makes must contain the same copyright and 

other proprietary notices that appear on or in the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as 

permitted by this agreement and that it will not use the Software in a manner 

inconsistent with its design or Documentation. 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or 

create Derivative Works of the Software or the Documentation; combine or merge any 

part of the Software or Documentation with or into any other software or documentation; 



or refer to or otherwise use the Software as part of any effort to develop software 

(including any routine, script, code, or program) having any functional attributes, visual 

expressions or other features similar to those of the Software to compete with Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark 

tests or analysis relating to the Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, 

disassemble, or otherwise attempt to discover the source code of the Software. 

6.5 No Unbundling. The Software may include various applications and components, 

may allow access to different Stellar Online Channels, may support multiple platforms 

and languages, and may be provided to Customer on multiple media or in multiple 

copies. Nonetheless, the Software is designed and provided to Customer as a single 

product to be used as a single product on Computers as permitted herein. Unless 

otherwise permitted in the Documentation, Customer is not required to install all 

component parts of the Software, but Customer shall not unbundle the component parts 

of the Software for use on different Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other 

product identification or proprietary rights notices, seal or instructional label printed or 

stamped on, affixed to, or encoded or recorded in or on any Software or Documentation; 

or fail to preserve all copyright and other proprietary notices in all copies Company 

makes of the Software and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing 

or similar on-demand computing environment unless Company’s Grant Letter or the 

applicable Product Entitlement Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its 

rights in the software (including without limitation, software obtained through a web 

download), or authorize any portion of the software to be copied onto another individual 

or legal entity’s computer except as may be expressly permitted herein. 



 
 

 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the 

Documentation anywhere in the world belong to, or are licensed to Stellar.  The rights 

granted to you in the Software are licensed (not sold), and you have no rights in, or to, 

the Software or the Documentation other than the right to use them in accordance with 

the terms of this License. The Software, its source code and Documentation are 

proprietary products of Stellar Information Technology Pvt. Ltd. (“Stellar”) to provide the 

License and are protected by copyright and other intellectual property laws. Stellar shall 

at all times retain all rights, title, interest, including intellectual property rights, in the 

Software or Documentation. 

8. WARRANTIES.  

The licensed software (excluding the media on which it is distributed) and all Stellar 

related websites and services are provided to licensee ‘AS IS’ and “AS AVAILABLE,” 

and Stellar and its suppliers and licensors make NO WARRANTY as to their use or 

performance. Stellar and its suppliers and licensors make NO WARRANTIES OR 

REPRESENTATIONS (express or implied, whether by statute, common law, custom, 

usage, or otherwise) as to any matter including without limitation to quality, availability, 

performance or functionality of the licensed software or any related Stellar websites or 

services; quality or accuracy of any information obtained from or available through use 

of the licensed software or related Stellar websites or services; any representation or 

warranty that the use of the licensed software or any related Stellar websites or services 

will be uninterrupted or always available (whether due to internet failure or otherwise), 

error-free, free of viruses or other harmful components or operate on or with any 

particular hardware, platform or software; non-infringement of third-party rights, 

merchantability, integration, satisfactory quality, or fitness for any particular purpose, 

except for, and only to the extent, that a warranty may not be excluded or limited by 

applicable law in licensee’s jurisdiction. 

9. DATA PROTECTION.   



You understand that by using the Licensed Software, you consent and agree to the 

collection and use of certain information about you and your use of the Licensed 

Software in accordance with Stellar’s Privacy Policy. You further consent and agree that 

Stellar may collect, use, transmit, process and maintain information related to your 

Account, and any devices or computers registered thereunder, for purposes of providing 

the Licensed Software, and any features therein, to you. Information collected by Stellar 

when you use the Licensed Software may also include technical or diagnostic 

information related to your use that may be used by Stellar to support, improve and 

enhance Stellar’s products and services. For more information please read our full 

privacy policy at “https://www.stellarinfo.com”, on the section Privacy Policy. You further 

understand and agree that this information may be transferred to the United States, 

India and/or other countries for storage, processing and use by Stellar, its affiliates, 

and/or their service providers. You hereby agree and consent to Stellar’s and its 

partners’ and licensors’ collection, use, transmission, processing and maintenance of 

such location and account data to provide and improve such features or services. 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s 

Computer, without notice, to automatically connect to the Internet and to communicate 

with Stellar website or Stellar domain for purposes such as license validation and 

providing Customer with additional information, features, or functionality. Unless 

otherwise specified in Sections 10.2 through 10.5, the following provisions apply to all 

automatic Internet connections by the Software: 

10.1.1 Whenever the Software makes an Internet connection and communicates with a 

Stellar website, whether automatically or due to explicit user request, the Privacy Policy 

shall apply. Stellar Privacy Policy allows tracking of website visits and it addresses in 

detail the topic of tracking and use of cookies, web beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer 

information is collected and transmitted by the Software to Stellar pursuant to the Stellar 

https://www.stellarinfo.com/


 
 

 

Online Privacy Policy available at https://www.stellarinfo.com/ under Privacy Policy 

section. 

10.1.3 If Customer accesses Stellar Online Service or activates or registers the 

Software, then additional information such as Customer’s ID, user name, and password 

may be transmitted to and stored by Stellar pursuant to the Privacy Policy and 

additional terms of use related to such Stellar Online Service. 

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional 

messages to facilitate the Stellar Online Service or the activation or registration of the 

Software or Stellar Online Service, or (b) deliver in-product marketing to provide 

information about the Software and other Stellar products and Services using 

information including but not limited to platform version, version of the Software, license 

status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional 

notice, to automatically connect to the Internet (intermittently or on a regular basis) to 

(a) check for Updates that are available for download to and installation on the 

Computer and (b) notify Stellar of the results of installation attempts. 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software 

Activation Key, (b) activate or reactivate the Software, (c) register the software, or (d) 

validate the Ownership. Such requirement may cause Customer’s Computer to connect 

to the Internet without notice on install, on launch, and on a regular basis thereafter. 

Once connected, the Software will collect and transmit information to Stellar. Software 

or Customer may also receive information from Stellar related to Customer’s license, 

subscription, or Ownership. Stellar may use such information to detect or prevent 

fraudulent or unauthorized use not in accordance with a valid license, subscription, or 

Ownership. Failure to activate or register the Software, validate the subscription or 

Ownership, or a determination by Stellar of fraudulent or unauthorized use of the 

Software may result in reduced functionality, inoperability of the Software, or a 

termination or suspension of the subscription or Ownership. 

https://www.stellarinfo.com/


10.4 Use of Online Services. The Software may cause Customer’s Computer, without 

additional notice and on an intermittent or regular basis, to automatically connect to the 

Internet to facilitate Customer’s access to content and services that are provided by 

Stellar or third parties. In addition, the Software may, without additional notice, 

automatically connect to the Internet to update downloadable materials from these 

online services so as to provide immediate availability of these services even when 

Customer is offline. 

10.5 Digital Certificates. The Software uses digital certificates to help Customer 

identify downloaded files (e.g., applications and/or content) and the publishers of those 

files. For example, Stellar uses digital certificates to help Customer identify the publisher 

of Stellar applications. Customer’s Computer may connect to the Internet at the time of 

validation of a digital certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or 

consequential damages whatsoever (including, without limitation, damages for loss of 

business profits, business interruption, loss of business information, or any other 

pecuniary loss) arising out of the use of or inability to use the software product or the 

provision of or failure to provide support services, even if Stellar has been advised of 

the possibility of such damages. In any case, Stellar’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product or a sum of 

US Dollars Five whichever is higher. 

12. TERMINATION       

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days 

after request from Stellar, Stellar may terminate this EULA, whereupon all rights granted 

to Customer shall immediately cease including but not limited to the license granted to 

the customer to use the software which shall also stand revoked. Furthermore, upon 

termination, Customer shall return to Stellar all copies of the Licensed Software, or 



 
 

 

verify in writing that all copies of the Licensed Software have been destroyed and failure 

of the customer  to do so would entitle Stellar to sue for relief in equity and damages. 

13. JURISDICTION AND LAW 

13.1 This EULA is subject to, and will be governed by and construed in accordance 

with the substantive laws applicable to the state of Delhi (India). Courts at Delhi, India 

alone shall have the jurisdiction to entertain any dispute arising out of the terms and 

conditions of this EULA and you consent to such jurisdiction of the courts at Delhi, India. 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or 

the United Nations Convention on Contracts for the International Sale of Goods, the 

application of which is expressly excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on 

the subject matter and merges and supersedes all other or prior understandings, 

purchase orders, agreements and arrangements.  

14.2 The exclusions of warranties and liability limitations shall survive the termination 

of this EULA, howsoever caused; but this survival shall not imply or create any 

continued right to use the Licensed Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or 

use Licensed Software in any manner prohibited by the applicable export control laws, 

notably where applicable, the United States Export Administration Act, restrictions, or 

regulations (collectively the 'Export Laws'.) All rights to use the Licensed Software are 

granted on condition that Licensee complies with the Export Laws, and all such rights 

are forfeited if Licensee fails to comply with the Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All 

rights are reserved under the copyright laws of India and/or of other countries, to Stellar 



Information Technology Pvt Ltd, having its registered office at 205, Skipper Corner, 88, 

Nehru Place, New Delhi, India 110019. 

14.5 There are no third party beneficiaries of any promises, obligations or 

representations made by Stellar herein.  

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute 

nor contribute to a waiver by Stellar of any other or future violation of the same provision 

or any other provision of this License. 

14.7 This EULA constitutes the entire agreement between you and Stellar and it 

supersedes all prior or contemporaneous representations, discussions, undertakings, 

communications, agreements, arrangements, advertisements, and understandings 

regulating the Licensed Software. This EULA is binding on and made for the benefit of 

the parties and their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed 

by an authorized officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 





 

About Stellar 

is the world's foremost Data Care Corporation, with expertise in Data 
Recovery, Data Erasure, Mailbox Conversion, and File Repair software and services. 
Stellar has been in existence from past 25+ years and is a customer-centric, critically 
acclaimed, global data recovery, data migration & erasure solutions provider with cost-
effective solutions available for large corporate, SMEs & Home Users. 

Stellar has a strong presence across USA, Europe & Asia. 

Product Line: 

Stellar provides a wide range of Do It Yourself (DIY) Software for Consumer as well as 
Software for Businesses: 

Data Recovery 

 

File Repair 

 

Data Erasure 

 

The widest range of data 
recovery software that 
helps you recover your 
valued data lost after 

accidental format, virus 
problems, software 

malfunction, file/directory 
deletion, or even 

sabotage! 

The most 
comprehensive range of 

file repair software for 
Windows, Mac and 
Linux. Recover your 

files, which have been 
infected by viruses, 

malwares or have been 
damaged by improper 
shutdown and other 
corruption-related 

issues. 

Best software for IT 
assets disposition. 
Secure and erase 

variety of storage media 
and files from 

PC/Laptop, Servers, 
Rack Drives or Mobile 

devices. Data once 
erased cannot be 

recovered by using any 
data recovery software 

or service.  

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

      

Email Repair & 
Converter 

 

Database Repair 

 

Email Backup Tools 

 

Robust applications to 
restore inaccessible 

Professional and reliable 
software to repair 

Fully featured backup 
utilities that provides a 

https://www.stellarinfo.com/disk-recovery.php
https://www.stellarinfo.com/file-repair/file-repair-software.php
https://www.stellarinfo.com/data-erasure/data-eraser-windows.php


 
 

 

mailboxes of MS 
Exchange, Outlook, 

AppleMail, Thunderbird, 
Eudora, Spicebird, 

Entourage, and 
Pocomail mailbox. Also, 

tools to convert 
mailboxes and database 
files from one format to 

another. 

corrupt or damaged 
database for Microsoft 

SQL Server, 
QuickBooks®, Microsoft 

Access, SQLite and 
many more. 

comprehensive solution 
in case of any disaster. 

These software 
facilitates taking back up 

of all your mails, 
contacts, tasks, notes, 

calendar entries, 
journals etc. with full & 

incremental backup 
options. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

      

Photo and Video Tools 

 

Utility Tools 

 

Stellar Toolkits 

 
Professional tools to 
rebuild damaged or 

corrupt photos, videos, 
audios, and other 

multimedia files, from 
Window and Mac 

systems. Recover files 
from hard drives, 

memory cards, iPods, 
USB flash drives, digital 

cameras, IBM Micro 
Drives and more. 

A range of utility 
software such as 

SpeedUp Mac, Drive 
Clone and Partition 
Manager for Mac 

systems as well as 
Password Recovery for 
Windows and Password 
Recovery for Windows 
Server based systems 

Stellar also provides 
toolkits that are 

combination of Powerful 
Tools Designed for Data 

Recovery, File repair, 
Mailbox repair and File 
Conversion. All in one 

power packed toolkits to 
meet the need of every 

business. 

 

Know More --> 
 

Know More --> 

 

Know More --> 

For more information about us, please visit www.stellarinfo.com. 
 

https://www.stellarinfo.com/mail-recovery.php
https://www.stellarinfo.com/database-recovery.php
https://www.stellarinfo.com/backup-mail.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/toolkit.php
http://www.stellarinfo.com/

